You can read the recommendations in the user guide, the technical guide or the installation guide for SAMSUNG BDH8500. You'll
find the answers to all your questions on the SAMSUNG BDH8500 in the user manual (information, specifications, safety advice,
size, accessories, etc.). Detailed instructions for use are in the User's Guide.
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Manual abstract:
"" When you connect the product to the TV using the HDMI cable for the first time or to a new TV, the HDMI output resolution will be automatically set to the
highest supported by the TV. "" A long HDMI cable may cause a screen noise. If this occurs, set HDMI Deep Colour to Off in the menu. "" If the product is
connected to your TV in the HDMI 720p, 1080i, or 1080p output mode, you must use a High speed (category 2) HDMI cable. "" HDMI outputs only a pure
digital signal to the TV. If your TV does not support HDCP (High-bandwidth Digital Content Protection), random noise appears on the screen. "" Do not
connect the power cord until you have made all the other connections. When you change the connections, turn off all devices before you start. "" If connecting
with 2 RF cables from the same satellite dish, you can watch and record different channels. Twin LNB is recommended.
Set "Aerial Connection Type" to "Dual" in the Broadcasting option. For H8509S,H8909S model "" If connecting with one RF cable, you cannot view second
channel while recording a channel. Set "Aerial Connection Type" to "Single" in the Broadcasting option. For H8509S,H8909S model Connecting to an Audio
System Method 1: Connecting to an HDMI supported AV receiver Method 2: Connecting to an AV receiver with Optical input "" After finishing the
connections, press the input selector of the connected audio system and TV until the video signal from the product appears on your TV and you hear the audio
signal through your audio system. "" Do not connect the power cord until you have made all the other connections.
When you change the connections, turn off all devices before you start. Connecting to a Network Router You can connect your product to your network router
using one of the methods illustrated below. Wired Network "" Internet access to Samsung’s software update server may not be allowed, depending on the
router you use or your ISP’s policy. For more information, contact your ISP (Internet Service Provider). "" For DSL users, please use a router to make a
network connection.
Wireless Network "" If the wireless router supports DHCP, your product can use a DHCP or static IP address to connect to the wireless network. "" Set your
wireless router to Infrastructure mode. Ad-hoc mode is not supported. "" The product supports only the following wireless security key protocols: WEP
(OPEN/ SHARED), WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES) "" Select a channel on the wireless router that is not currently being used. If the channel
set for the wireless router is currently being used by another device nearby, it will result in interference and communication failure. "" If you select the Pure
High-throughput (Greenfield) 802.11n mode and set the Encryption type on your router or router to WEP, TKIP or TKIP-AES (WPS2Mixed), the product will
not support a connection in compliance with new Wi-Fi certification specifications. "" If your router supports WPS (Wi-Fi Protected Setup), you can connect
to the network via PBC (Push Button Configuration) or PIN (Personal Identification Number). WPS will automatically configure the SSID and WPA key in
either mode. "" Wireless LAN, by its nature, may cause interference, depending on the operating conditions (router performance, distance, obstacles,
interference by other radio devices, etc).
The Home Screen PLAY DISC FILMS AND TV SHOWS MULTIMEDIA SAMSUNG APPS Audio CD WebBrowser e-Manual 3 4 5 6 Recorded Schedule
Screen TV Manager Mirroring Settings PLAY DISC : Lets you play photos, videos, or music content from Disc. FILMS AND TV SHOWS : Lets you view
Films and TV Shows from the Internet. "" Depending on your country, this menu function may not be supported. MULTIMEDIA : Lets you play photos,
videos, or music content from USB or mobile devices, or PCs. Sign In : Lets you log in with your Samsung account. Search : Lets you search for contents in
Films and TV Shows, Apps and YouTube by entering corresponding search words SAMSUNG APPS : Gives you access to various for applications you can
download. My Apps : Apps downloaded from My Apps are displayed. Recorded TV : Access Recorded TV directly. Schedule Manager : Reserve the desired
TV programmes. Screen Mirroring : Lets you view the screen of your smart phone or android tablet on a TV you have connected to the product.
Settings : Opens the product's menu. In the menu can set various functions to suit your personal preferences. "" In the Home menu screen, it will switch to
DTV Channel mode after 3 minutes. When accessing the Settings menu, the screen saver will be activated after 5 minutes. Saves power by turning off product
automatically when no user operation is received for 4 hours.
If Auto Power Off menu is set to Off, the power will not turn off automatically. Picture Picture UHD Output 3D Settings TV Aspect Ratio BD Wise Resolution
DTV Smart Resolution Movie Frame (24fps) 16:9 Original Off Auto Off Auto Auto UHD Output For BD-H89 series This option outputs HDMI video at UHD
(Ultra High definition) resolution. This is only available when Movie Frame is set to Auto. "" To use this feature, you must connect the product to a device
that supports UHD resolution and you must have content that plays at 24fs (film speed). "" This device cannot play UHD contents However contents with
resolution lower than Full HD can be up-scaled to UHD.
"" For UHD resolution output, only 2160*3840 24 frame rate output is available. 3D Settings Select whether to play a Blu-ray Disc with 3D contents in 3D
Mode. "" If you move to the Home or Samsung Apps screen while in 3D mode, the product will switch to 2D mode automatically. 3D Blu-ray Playback Mode
Try Now Set whether to play 3D Blu-ray disc in 3D or 2D image. ●●Auto : Automatically detect if a connected TV has 3D capability and play a Blu- ray 3D
disc in 3D or 2D accordingoperation of BD Wise, set the BD Wise menu of both the product and the TV to On. Resolution Try Now Set the output resolution
of the HDMI video signal. The number indicates the number of lines of video per frame. The i and p indicate interlaced and progressive scan, respectively.
The more lines, the higher quality. ●●BD Wise : Automatically sets the resolution to the resolution of the play contents.
if you have connected the product via HDMI to a TV with the BD Wise feature. (The BD Wise menu item appears only if BD Wise is set to On. See BD Wise
above.) ●●Auto : Automatically sets the output resolution to the connected TV’s maximum resolution. ●●1080p : Outputs 1080 lines of progressive video.
●●1080i : Outputs 1080 lines of interlaced video. ●●720p : Outputs 720 lines of progressive video. ●●576p/480p : Outputs 576/480 lines of progressive
video.
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Resolution according to the output mode ●●Blu-ray Disc/E-contents/Digital Contents/DTV/DVD playback For BD-H85 series Resolution BD Wise Auto
1080p 1080i 720p 576p/480p For BD-H89 series E-contents/ Digital contents 1080p 2160p@24F Blu-ray Disc E-contents/Digital contents/DTV DVD
Resolution of Blu-ray 1080p 576i/480i Disc Max. Resolution of TV Max.
Resolution of TV Max. Resolution of TV input input input 1080p 1080p 1080p 1080i 1080i 1080i 720p 720p 720p 576p/480p 576p/480p 576p/480p Resolution
Blu-ray Disc Resolution of Blu-ray Disc 2160p@24F DTV DVD BD Wise Auto Movie Frame : Auto (UHD Output : Auto) 1080p 576i/480i Max. Max.
Resolution of Resolution of TV input TV input Max. Max.
Movie Frame : Off Resolution of Resolution of TV input TV input 1080p 1080p 1080p 1080i 1080i 1080i 720p 720p 720p 576p/480p 576p/480p 576p/480p
1080p 1080i 720p 576p/480p 1080p 1080i 720p 576p/480p "" If the screen stays blank after you have changed the resolution, remove all discs, and then press
the HOME button on the remote control. Press and hold the ' button on the top of the product for more than 5 seconds. All settings are restored to the factory
default. "" @@"" The Blu-ray Disc must have the 24 frame feature for the product to use the Movie Frame (24fps) mode. DTV Smart Resolution Try Now
Use this function to automatically optimise screen resolution for digital broadcasts.
●●Auto : Screen resolution is automatically optimised for digital broadcast. ●●Off : Turn off DTV Smart Resolution. "" When you change your TV channel
with this function set to Auto, according your TV, the display time of next channels may take longer than the function set to Off. "" DTV smart resolution is
activated only when resolution option is set to Auto. Movie Frame (24fps) Try Now Setting the Movie Frame (24fps) feature to Auto lets the play adjust its
HDMI output to 24 frames per second for improved picture quality. You can enjoy the Movie Frame (24fps) feature only on a TV supporting this frame rate.
Movie Frame is only available when the product is in the 1080p output resolution modes. ●●Auto : Movie Frame (24fps) functions work. ●●Off : Movie
Frame (24fps) functions are off. Fit Screen Size Try Now Set the screen to the optimal size.
(Apply Smart Hub, Screen Mirroring only) "" If displayed e-Manual page on your TV screen is incomplete and partially hidden, set he Fit Screen Size to Size
1. HDMI Colour Format Try Now Set the colour space format for HDMI output, depending on the connected device. ●●Auto : Automatically set the
optimum format supported by the connected display device. ●●YCbCr (4:4:4) : Recommended when connected to a display that supported YCbCr (4:4:4)
because most films are in this format. ●●RGB (Standard) : Recommended when connected to a display that does not support the YCbCr format. Select this for
output of the normal range of RGB colours. ●●RGB (Enhanced) : Select this for output of an enhanced range of RGB colours. Not recommended for general
use because it will increase the contrast between black and white. HDMI Deep Colour Try Now Lets you output video from the HDMI OUT jack with Deep
colour. Deep colour provides more accurate colour reproduction with greater colour depth.
●●Auto : The product outputs video with Deep Colour to a connected TV which supports HDMI Deep Colour. ●●Off : The picture is output without Deep
Colour. Progressive Mode Try Now Lets you improve picture quality when viewing DVDs. ●●Auto : Select to have the product automatically select the best
picture quality for the DVD you’re watching. ●●Video : Select for the best picture quality from concert or TV show DVDs.
Sound Sound Digital Output PCM Downsampling Dynamic Range Control Downmixing Mode DTS Neo:6 Mode PCM On Auto Normal Stereo Off Audio Sync
0 ms Connected Device AV Receiver Digital Output Try Now You set the Digital Output to match the capabilities of the AV receiver you’ve connected to the
product : ●●PCM : Choose if you have connected an HDMI supported AV receiver. ●●Bitstream (Unprocessed) : Select if you have connected an HDMI
supported AV receiver with Dolby TrueHD and DTS-HD Master Audio decoding capabilities. ●●Bitstream (Re-encoded DTS) : Choose if you have connected
an AV receiver using a Digital Optical input that can decode DTS. ●●Bitstream (Re-encoded Dolby D) : Select if you don’t have an HDMI supported AV
receiver, but have an AV receiver with Dolby Digital decoding capabilities. "" Be sure to select the correct Digital Output or you will hear no sound or a loud
noise.
"" If the HDMI device (AV receiver, TV) is not compatible with compressed formats (Dolby digital, DTS), the audio signal outputs as PCM. "" Regular DVDs
do not have BONUSVIEW audio and Navigation Sound Effects. Digital Output Selection Audio Stream on Blu-ray Disc Setup Connection Audio source
stream PCM Dolby Digital Dolby Digital Plus HDMI supported Avreceiver Dolby TrueHD DTS DTSHD High Resolution Audio DTS-HD Master Audio PCM
Dolby Digital Dolby Digital Plus Dolby TrueHD DTS DTSHD High Resolution Audio DTS-HD Master Audio PCM Dolby Digital Dolby Digital Plus Dolby
TrueHD DTS DTSHD High Resolution Audio DTS-HD Master Audio Bitstream (Unprocessed) PCM Dolby Digital Dolby Digital Plus Dolby TrueHD DTS
DTSHD High Resolution Audio DTS-HD Master Audio Outputs Up to PCM 7.1ch Up to PCM 7.1ch Up to PCM 7.1ch Up to PCM 7.1ch Up to PCM 6.1ch Up
to PCM 7.1ch Up to PCM 7.1ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch PCM Dolby Digital Dolby Digital Plus Dolby TrueHD
DTS DTSHD High Resolution Audio DTS-HD Master Audio PCM 2ch Dolby Digital Dolby Digital Dolby Digital DTS DTS DTS PCM Optical HDMI
supported AV receiver Optical Setup Connection Audio source stream PCM Dolby Digital Dolby Digital Plus Outputs Re-encoded DTS Re-encoded DTS Reencoded DTS Re-encoded DTS Re-encoded DTS Re-encoded DTS Re-encoded DTS Re-encoded Dolby Digital * Re-encoded Dolby Digital * Re-encoded
Dolby Digital * Re-encoded Dolby Digital * Re-encoded Dolby Digital * Re-encoded Dolby Digital * Re-encoded Dolby Digital * Bitstream (Reencoded
DTS) HDMI supported AV receiver or Optical Dolby TrueHD DTS DTSHD High Resolution Audio DTS-HD Master Audio PCM Dolby Digital Dolby Digital
Plus Bitstream (Reencoded Dolby D) HDMI supported AV receiver or Optical Dolby TrueHD DTS DTSHD High Resolution Audio DTS-HD Master Audio
Audio Stream on DVD Setup Connection HDMI supported AVreceiver PCM Optical Audio source stream PCM Dolby Digital DTS PCM Dolby Digital DTS
PCM Dolby Digital DTS Optical PCM Dolby Digital DTS PCM Dolby Digital DTS Outputs PCM 2ch Up to PCM 5.
1ch Up to PCM 6.1ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch Dolby Digital DTS PCM 2ch Dolby Digital DTS PCM 2ch Dolby Digital DTS HDMI
supportedAV receiver Bitstream (Unprocessed) Bitstream (Reencoded DTS) HDMI supported AV receiver or Optical Setup Bitstream (Reencoded Dolby D)
Connection HDMI supported AV receiver or Optical Audio source stream PCM Dolby Digital DTS Outputs PCM 2ch Dolby Digital DTS Audio Stream of
Broadcast Setup Connection Audio source stream Dolby Digital Dolby Digital Plus HDMI supported AVreceiver PCM MPEG1 Layer 2 HE-AAC Dolby
Digital Dolby Digital Plus MPEG1 Layer 2 HE-AAC Dolby Digital Dolby Digital Plus MPEG1 Layer 2 HE-AAC Dolby Digital Dolby Digital Plus MPEG1
Layer 2 HE-AAC Dolby Digital Dolby Digital Plus Bitstream (Reencoded DTS) HDMI supported AV receiver or Optical MPEG1 Layer 2 HE-AAC Dolby
Digital Dolby Digital Plus Bitstream (Reencoded Dolby D) HDMI supported AV receiver or Optical MPEG1 Layer 2 HE-AAC Outputs Up to PCM 5.
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1ch Up to PCM 5.1ch Up to PCM 5.1ch Up to PCM 5.1ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch Dolby Digital Dolby Digital Plus** PCM 2ch Re-encoded
Dolby Digital *** Dolby Digital Dolby Digital PCM 2ch Re-encoded Dolby Digital *** Re-encoded DTS Re-encoded DTS PCM 2ch Re-encoded DTS *** Reencoded Dolby Digital Re-encoded Dolby Digital PCM 2ch Re-encoded Dolby Digital *** Optical HDMI supported AV receiver Bitstream (Unprocessed)
Optical Definition for Blu-ray Disc Setup Connection Audio source stream Outputs Decodes the main feature audio and BONUSVIEW audio stream together
into PCM audio and adds Navigation Sound Effects. Outputs only the main feature audio stream so that your AV receiver can decode the audio bitstream. You
will not hear BONUSVIEW audio or Navigation Sound Effects. Decodes the main feature audio and BONUSVIEW audio stream together into PCM audio and
adds Navigation Sound Effects, then reencodes the PCM audio into DTS bitstream. Decodes the main feature audio and BONUSVIEW audio stream together
into PCM audio and adds Navigation Sound Effects, then reencodes the PCM audio into Dolby Digital bitstream.
PCM HDMI supported AVreceiver Optical Any Bitstream (Unprocessed) HDMI supported AV receiver Optical Any Bitstream (Reencoded DTS) HDMI
supported AV receiver or Optical Any Bitstream (Reencoded Dolby D) HDMI supported AV receiver or Optical Any * If the Source Stream is 2ch or mono,
"Re-encoded Dolby D" setting is not applied. Output will be PCM 2ch. ** If the Audio Description is set to On, audio output will be changed Dolby Digital
even if the original broadcast stream is Dolby Digital Plus. *** If the Audio Description is set to On and sampling rate of less 48kHz, audio output will be
changed PCM even if the Bitstream is selected. PCM Downsampling Try Now Set whether to use downsampling processing or not.
●●Off : Select when the AV receiver connected to the product is 96kHz compatible. ●●On : Select when the AV receiver connected to the product is not
96kHz compatible. 96kHz signals will be down converted to 48kHz. "" Even when PCM Downsampling is set to Off, some discs will only output downsampled
audio through the optical digital outputs. "" If your TV is not compatible with compressed multi-channel formats (Dolby Digital, DTS), the product may
output PCM 2ch downmixed audio even though you set the digital output as Bitstream (unprocessed/Re-encoded DTS/Re-encoded Dolby D) on your setup
menu.
"" If your TV is not compatible with PCM sampling rates over 48kHz, the product may output 48kHz downsampled PCM audio even though you set PCM
Downsampling to Off. Dynamic Range Control Try Now Set Dynamic Range control option for Dolby Digital, Dolby Digital Plus and Dolby TrueHD.
●●Auto : The Dynamic Range will be controlled automatically based on the information provided by the Dolby TrueHD Soundtrack. This setting is same with
"On" for Dolby Digital and Dolby Digital Plus. ●●Off : You can enjoy original sound without compressing Dynamic Range of the sound. ●●On : The
Dynamic Range is compressed appropriately by boosting low level sound and reducing extremely loud sound. Downmixing Mode Try Now Select Downmix
method for stereo output. ●●Normal Stereo : Downmixes the multi-channel audio into two channel stereo. Choose when connected to equipment that does not
support virtual surround functions such as Dolby Pro Logic. ●●Surround Compatible : Downmixes multi-channel audio into surround compatible stereo.
Choose when connected to equipment that supports virtual surround functions such as Dolby Pro Logic. DTS Neo:6 Mode Try Now You can enjoy
multichannel sound via HDMI output even for 2 channels audio source. ●●Off : Outputs a 2-channel audio signal through the front speakers only.
●●Cinema : Select to play 2-channel movie sound over multi-channels. ●●Music : Select to play 2-channel music over multi-channels. "" If you are using an
HDMI supported AV receiver, this option is available when you set Digital Output setup as PCM. Audio Sync Try Now In some cases when the product is
connected to a digital TV, the audio signal may not synchronize with the video signal. If this occurs, adjust the audio delay time to match the video signal.
●●You can set the audio delay time between 0 msec and 250 msec. Adjust it to the optimal setting.
"" The audio delay time you specify may not be exact depending on the played content. Connected Device Try Now Choose an equipment that you have
connected to this product to hear the sound in addition to your TV. Loudness of DTV Programme will be adjusted according to your equipment. ●●AV
Receiver : Select this If you use a general AV Receiver / Home Theatre Equipment or a Television to hear sound. ●●AV Receiver (Offset Mode) : Select this if
your case is one of two shown below.
–– If you use THX Certified AV Receiver / Home Theatre Equipment. –– In case Digital Output is set to Bitstream, and If you feel the Dolby Audio much
louder than MPEG1 Layer2 Audio while watching DTV Programme, select this even if your AV Receiver is not THX Certified one. ●●Stereo Device : Select
this if you use a Stereo Amplifier or Recording Device that support Optical Digital Audio Input as PCM format. "" For users whose TV is the only soundproducing device: 1) If the TV does not support Dolby Digital bitstream input via HDMI, no specific setting is required. 2) If the TV supports Dolby Digital
bitstream input via HDMI, set Connected Device to Stereo.
"" If the DTV Programme you are watching is produced according to EBU R128, The Average Loudness between MPEG1 Layer2 Audio, Dolby Digital
Audio, Dolby Digital Plus Audio, HE-AAC Audio can be reduced. If the DTV Programme do not meet the EBU R128, there may be still some amount of
difference of average Loudness between a TV Programmes. "" Substantial number of AV Receiver / Home Theatre Device decode Dolby Digital / Dolby
Digital Plus with +4dB OFFSET when compared to same encoding level of PCM input. This kind of product include both THX Certified one and also none
THX Certified one. If user select "AV Receiver (Offset Mode)", the average loudness between Dolby Digtial / Dolby Digital Plus audio decoded by such a
product and MPEG1 Layer2 Audio decoded by this product will be similar. Broadcasting You can configure your TV channels with features such as country
and auto tune. Broadcasting Auto Tuning Aerial Terrestrial Channel List Guide Schedule Manager Edit Channel Edit Favourites Auto Tuning Try Now
Scans all channels and stores them in the product’s memory. Auto Tuning Configure auto-tuning settings to scan and store channels. Standby Auto Tuning
Auto-tune channels while your device is in standby mode. "" This menu can be available when country set to Hungary, Finland and Italy and TV mode is
Astra HD + or Sky.
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Cable Search Option Except for H8509S, H8909S, H8500A, H8900A model Configure search settings, such as frequency and symbol rate, for cable
network. Wake-up Timer Schedule timer to turn the TV on and scan channels automatically. "" This menu can be available when country set to Hungary,
Finland and Italy and TV mode is Astra HD + or Sky. Aerial Except for H8500A, H8900A, H8509S, H8909S model Selects an appropriate type of aerial for
digital broadcasts. Before your product can begin memorizing the available channels, you must specify the type of signal source that is connected to the this
product. Channel List Try Now Select this to check the stored channels. You can see TV channels in several ways. Guide Try Now Provide programme
information for each channels. "" Depending on your country, this menu function may not be supported. Schedule Manager Try Now It can manager lists for
schedule viewing or recording.
"" Depending on your country, this menu function may not be supported. Edit Channel Try Now It is provided to edit functions for channel. Edit Favourites
Try Now It is provided to make and edit favourite lists for channel. Channel Settings Country (Area) Try Now Select your country so that the TV can
correctly auto-tune the broadcasting channels. "" Password : Enter the desired 4-digit password using the number buttons.
1) Belgium, France, Italy, Norway : You can not set the password to "0000". Please choose other numbers. 2) Others : Default password is set to 0000. ""
Channel Ordering menu can be displayed when the country set to Italy. Manual Tuning Try Now Scans for a channel manually and stores in the product.
When scanning has finished, channels are updated in the channel list. Transfer Channel list Try Now This function can import or export the channel map.
You should connect a USB storage to use this function. ●●Import from USB : Import channel list from USB. ●●Export to USB : Export channel list to USB.
"" If you set the country to Netherlands and Antenna source set to cable, this menu will not appear. Delete CAM operator profile Except for H8500A,
H8900A model Select this menu to delete the CAM operator profile. Satellite System For H8509S, H8909S model Configure settings for your satellite
equipment. ●●Satellite Selection : Choose one or more satelites for your product. ●●LNB Power : Enable or disable LNB Power supply from receiver.
●●LNB Settings : Configure parameters for your satelite equipment. ●●SatCR/Unicable Settings : Configure single cable installation. "" Depending on your
country, this menu function may not be supported. ●●Positioner Settings : Configure the settings for your aerial positioner. ●●Reset All Settings : Restrore
all settings to defaults. Channel Lock Try Now Prevent your children from accessing harmful content by locking channels. When "Channel Lock" set to "on",
navigate to the "Edit Channel" Screen, select the channels you wish to lock, select the "Lock", and then enter the PIN code. This locks the selected channels.
Subtitle Try Now Configures the subtitle options. Primary Subtitle Language Try Now Select the Primary Subtitle language.
Secondary Subtitle Language Try Now Select the Secondary Subtitle language. Audio Language Try Now Select the type of Audio Language. Edit Channel
Number Use this to change channel number. "" Depending on your country, this menu function may not be supported. Primary Audio Language Try Now
Select the Primary Audio language.
Secondary Audio Language Try Now Select the Secondary Audio language. Programme Rating Lock Try Now Block some programmes. (Depending on the
country) "" Password : Enter the desired 4-digit password using the number buttons. 1) Belgium, France, Italy, Norway : You can not set the password to
"0000". Please choose other numbers.
2) Others : Default password is set to 0000. Data Service Activates or deactivates the data service. "" Depending on your country or region, this menu
function may not be supported. Digital Text If the programme broadcasts with digital text, this feature is enabled. "" Depending on your country or region,
this menu function may not be supported. Teletext Language Try Now Set teletext language. Primary Teletext Language Try Now Select the primary teletext
language. Secondary Teletext Language Try Now Select the secondary teletext language. RF Bypass Gain For BD-H8500N, H8900N model When the TV
and product are connected together with a RF cable, this function prevents the distortion of the broadcast signal when watching a TV channel while the
product is powered off. "" Power consumption will be increased when you use this function.
Aerial Connection Type For H8509S, H8909S model Choose Single or Dual depending on the number of aerial cables connected. Common Interface Except
for BD-H8500A, H8900A model Show common interface menu and application information. ●●CI Menu : This enables the user to select from the CAM
provided menu. Select the CI Menu based on the menu PC Card. ●●CAM video transcoding : You can configure the setting to transcode the video codec from
the CAM automatically. Turn it Off if you do not want to use it. "" You must use a CAM that supports transcoding the video codec. ●●Application Info : View
information on the CAM(Conditional Access Module) inserted into the CI. Slot and on the "CI CAM with CI or CI+ CARD" which is inserted into the CAM.
You can install the CAM anytime whether the product is on or off.
●●CICAM PIN Manager : Save or clear CI CAM PIN numbers. "" Insert the CI or CI+ card to view a paid channel. (Please refer to "Watching TV
Channels".) Network When you connect this product to a network, you can use network based applications and functions, and upgrade the product's software
through the network connection. To use network services, you must connect the product to the network.
Network Network Status Network Settings Wi-Fi Direct Content Sharing Set Remote Access Device Name [BD]H8900 BD-Live Settings Network Status Try
Now Lets you check the current network and Internet status. Network Settings Try Now Before you begin, contact your ISP to find out if your IP address is
static or dynamic. If it is dynamic, and you have a wired or wireless network, we recommend using the Automatic configuration procedures described below.
If you are connecting to a wired network, connect the product to your router using a LAN cable before you start the configuration procedure. If you are
connecting to a wireless network, disconnect any wired network connection before you begin.
(Please refer to "Connecting to a Network Router".) Wired Network Wired - Automatic 1. 2. 3. 4. In the Home screen, select Settings, and then press the E
button.
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Select Network, and then press the E button. Select Network Settings, and then press the E button. Select Wired in the Network Settings screen, and then press
the E button. Network Settings Select your network type.
Network type Wired Connect Plug a network cable into the back of your Blu-ray player. 5. Select the Connect, and then press the E button. The product
detects the wired connection, verifies the network connection and then connects to the network. Wired - Manual If you have a static IP address or the
Automatic procedure does not work, you'll need to set the Network Settings values manually. Follow Steps 1 and 2 in Wired - Automatic and then follow these
steps: 1. Select Network Status. The product searches for a network, and then displays the connection failed message. 2. On the bottom of the screen, select IP
Settings, and then press the E button.
The IP Settings screen appears. 3. Select the IP Setting field, and then press the E button. 4. Select Enter manually in the IP Setting field, and then press the E
button.
5. Select a value to enter (IP Address, for example), and then press the E button. Use the number keypad on your remote control to enter the numbers for the
value. You can also enter numbers using the ▲▼ buttons. Use the ◀▶ buttons on the remote control to move from entry field to entry field within a value.
When done with one value, press the E button. 6. Press the ▲ or ▼ button to move to another value, and then enter the numbers for that value following the
instructions in Step 5. 7. Repeat Steps 5 and 6 until you have filled in all values. "" You can get the Network values from your Internet provider. 8. When
finished entering all the values, select OK, and then press the E button. The product verifies the network connection and then connects to the network.
Wireless Network You can setup a wireless network connection in four ways: –– Wireless Automatic –– Wireless Manual –– WPS(PBC) –– WPS(PIN) When
you configure the wireless network connection, any wireless network devices currently connected through the product or, if applicable, the product's current
wired connection, will be disconnected.
Wireless - Automatic 1. 2. 3. 4. In the Home screen, select Settings, and then press the E button. Select Network, and then press the E button. Select Network
Settings, and then press the E button. Select Wireless in the Network Settings screen, and then press the E button. The product searches for and then displays a
list of the available networks. Network Settings Select your network type.
Network type Wireless Wireless network iptime linksys3 iptime23 You can connect your Bluray player to the internet. Please select which wireless network to
use. Refresh WPS(PBC) 5. Select the desired network, and then press the E button. 6.
On the Security screen, enter your network's Security Code or Pass Phrase. Enter numbers directly using the number buttons on your remote control. Enter
letters by selecting a letter with an arrow button, and then pressing E button. "" To view the password as you enter it, use the arrow buttons to select Show
Password on the right side, and then press E button. 7.
When finished, select Done and then press the E button. The product verifies the network connection and then connects to the network. 8. When verification is
complete, select OK, and then press the E button. "" You should be able to find the Security Code or Pass Phrase on one of the set up screens you used to set
up your router or modem. Wireless - Manual If you have a static IP address or the Automatic procedure does not work, you'll need to set the Network Settings
values manually. 1. Follow the directions in Wireless - Automatic through Step 5. 2. The product searches for a network, and then displays the connection
failed message.
3. On the bottom of the screen, select IP Settings, and then press the E button. The IP Settings screen appears. 4. Select the IP Setting field, and then press the
E button. 5. Select Enter manually in the IP Setting field, and then press the E button. 6. Select a value to enter (IP Address, for example), and then press E
button. Use the number keypad on your remote control to enter the numbers for the value.
You can also enter numbers using the ▲▼ buttons. Use the ◀▶ buttons on the remote control to move from entry field to entry field within a value. When done
with one value, press the E button. 7. Press the ▲ or ▼ button to move to another value, and then enter the numbers for that value following the instructions in
Step 6.
8. Repeat Steps 6 and 7 until you have filled in all values. "" You can get the Network values from your Internet provider. 9. When finished, select OK, and
then press the E button.
The Security Screen appears. 10. On the Security screen, enter your network's Security Code or Pass Phrase. Enter numbers directly using the number buttons
on your remote control. Enter letters by selecting a letter with the ▲▼◀▶ buttons, and then pressing the E button. 11. When finished, select Done at the right
of the screen, and then press the E button. The product verifies the network connection and then connects to the network. 12. After the product verifies the
network, select OK, and then press the E button.
WPS(PBC) 1. 2. 3. 4. 5. In the Home screen, select Settings, and then press the E button. Select Network, and then press the E button. Select Network Settings,
and then press the E button. Select Wireless in the Network Settings screen, and then press the E button. Press the ▲ button on your remote, and then press the
▶ button to select the WPS(PBC).
wirless router within the next two minutes." message appears. 6. Press the E button on your remote. The "Press the PBC button on your 7.
Press the WPS(PBC) button on your router within two minutes. Your product automatically acquires all the network settings values it needs and connects to
your network. The Network Status screen appears. The product connects to the network after the network connection is verified. WPS(PIN) Before you begin,
open the router's setup menu on your PC and access the screen with the WPS PIN entry field.
1. 2. 3. 4. In the Home screen, select Settings, and then press the E button. Select Network, and then press the E button. Select Network Settings, and then
press the E button. Select Wireless in the Network Settings screen, and then press the E button. The product searches for and then displays a list of the
available networks. 5.
Select the desired network, and then press the E button. 6. Select the WPS(PIN), and then press the E button. The PIN pop-up appears. 7. Enter the PIN into
the WPS PIN entry field in the router's Set Up screen and then save the screen. "" Contact the manufacturer of the router for instructions explaining how to
access the route's Set Up screens or refer to the router's user's manual.
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"" For a WPS connection, set your wireless router's security encryption method to AES. WPS connections do not support WEP security encryption. Wi-Fi
Direct The Wi-Fi Direct function allows you to connect Wi-Fi Direct devices to the product and each other using a peer-to-peer network, without a wireless
router.
"" Bluetooth transmissions can interfere with the Wi-Fi Direct signal. Before you use the Wi-Fi Direct function, we strongly recommend that you turn off the
Bluetooth function of any active mobile device. 1. 2. 3.
4. Turn on the Wi-Fi Direct device and activate its Wi-Fi Direct function. In the Home screen, select Settings, and then press the E button. Select Network,
and then press the E button. Select Wi-Fi Direct, and then press the E button.
The Wi-Fi Direct devices that you can connect appear. "" The wired or wireless network connection will be disconnected when you use the Wi-Fi Direct
function. "" Some Wi-Fi Direct devices may not support the Content Sharing function if connected via Wi-Fi Direct. If this is the case, it is advisable to
change the network connection method between devices. Content Sharing Multimedia Device Settings Allow other devices on your network, like smart phones
and tablets, to share content with your product. Share Hard Drive Set whether to share content from this product with other network connected devices, such
as smart phone. "" If this menu is set to On, Auto Power Off function is not available. Set Remote Access Remote access allows you to access and control your
product from other devices. You have to log in Samsung account ID to use Remote Access functions with Samsung product. Register to Samsung Link Register
this device to Samsung Link to share content.
Only available with Samsung product supporting Samsung Link functionality. Device Name Lets you input a name for the product that will identify it on your
networks. BD-Live Settings Try Now Set various BD-Live function. BD-Live allows you to access extra features available on some Blu-ray discs if you are
connected to the Internet. BD-Live Internet Connection Try Now Lets you fully allow, partly allow, or prohibit a BD-Live Internet connection. Delete BD
Data Try Now Once the product is connected to your network, you can enjoy various movie related service contents available on BD-LIVE compliant discs.
By default, the memory is configured and requires no separate settings. If there is not enough free space and disturbs BD-Live operation, delete BD Data to
free memory space. Smart Hub Set your preferences for using Apps. Smart Hub Apps Settings VOD Rating Lock Terms & Policy Samsung account Terms and
Conditions, Privacy Policy Reset Smart Hub Off Apps Settings Lets you configure App notification settings and view basic info about your Apps.
Auto Ticker This automatically turns on the selected ticker service. Channel-Bound Apps Enable or disable Channel-Bound Apps. Channel-Bound Apps are
found on certain channels and provide additional information or services. VOD Rating Lock You can lock access to Video on Demand (VOD) content based
on its rating. "" Depending on your country, this menu function may not be supported.
"" If you haven't logged into your Samsung account, this function is not available. Terms & Policy You must review and agree to both the App Terms &
Conditions and the privacy policy to use App services. Samsung account Terms and Conditions, Privacy Policy You can view and agree to the terms or
privacy policy for your Samsung account and a variety of other services. ●●Samsung account terms & conditions ●●Samsung account Privacy Policy
●●Terms and Conditions for Recommendations ●●Recommendations Privacy Notice Reset Smart Hub Try Now Reset your App services and Samsung
account settings stored on your device. System System Setup Language Device Manager Clock Storage Device Manager Auto Power Off Security Off Setup
Try Now Sets the channels and the time when setting up this product for the first time or when resetting it.
Language Try Now You can select the language you prefer for the On-screen menu, disc menu, etc. "" The selected language will only appear if it is
supported. Device Manager Try Now Setup input devices to use with this product. You can check your device list and adjust the settings in this menu.
Keyboard Settings Try Now Lets you configure a wireless USB keyboard connected to the product. Mouse Settings Try Now Lets you configure a wireless
USB mouse connected to the product. You can use the mouse in the product's menu in the same way you use a mouse on your PC. To use a mouse with the
product's menu: 1. Connect the USB mouse to the product. 2.
Click the primary button you selected in Mouse Settings. The Simple Menu appears. 3. Click the menu options you want. "" Depending on the model of the
USB HID keyboard and mouse may not be compatible with your product. "" Some HID keyboard keys may not work. "" Wired USB keyboards are not
supported. "" Some applications may not be supported. "" If a wireless HID Keyboard does not operate because of interference, move the keyboard closer to
the product. Clock Try Now Sets the current date and time.
"" If Schedule Viewing and Schedule Recording is set using GUIDE, Channel List, or Info menu, It will work based on the time information of the TV
programme. If you set the Clock Mode to Manual and change time manually, Schedule Viewing and Schedule Recording function can be limited or work
abnormally. Storage Device Manager Try Now Format Device Try Now Format selected device. All contents will be deleted from that device. Check Device
Try Now Check to see if there is an error with the selected device.
Device Performance Test Try Now Test the recording performance of the device. "" Since the product's Timeshift and other implemented functions require a
certain amount of HDD space allocated internally, the total size shown in the Storage Device Manager of Settings menu may differ from the HDD's capacity
shown in the manual. Select Device for Recording Change the location of where you store recorded files. Auto Power Off Try Now Saves power by turning
off your product automatically when no user operation is received for setting time(4hours, 6hours, 8hours). "" This function isn't available when Share Hard
Drive is set to On.
Security Try Now This function works in conjunction with Blu-ray Disc/DVDs that have been assigned an age rating or numeric rating that indicates the
maturity level of the content. These numbers help you control the types of Blu-ray Disc/DVDs that your family can watch. When you access this function, the
security screen appears. Enter the your Security PIN. "" Password : Enter the desired 4-digit password using the number buttons. 1) Belgium, France, Italy,
Norway : You can not set the password to "0000".
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Please choose other numbers. 2) Others : Default password is set to 0000. BD Parental Rating Prevent playback of Blu-ray Discs with specific age ratings
unless a PIN is entered. DVD Parental Rating Prevent playback of DVDs with specific numerical ratings unless a PIN is entered.
A larger number indicates that the programme is intended for adult use only. Change PIN Change the 4-digit PIN used to access security functions. General
Try Now You can change the options listed below to match your preferences. Advanced Music Copy Try Now When you copy music files, information can be
updated automatically. The copying time may be increased. "" This feature is available only when the product is connected to the network. Menu
Transparency Try Now Adjust the transparency of the menu box. Anynet+ (HDMI-CEC) Try Now Anynet+ is a convenient function that offers linked
operations with other Samsung products that have the Anynet+ feature. To operate this function, connect this product to an Anynet+ Samsung TV using an
HDMI cable. DivX® Video On Demand Try Now View DivX® VOD Registration Codes to purchase and play DivX® VOD contents.
Support Support Remote Management e-Manual Software Update Contact Samsung Reset Remote Management Try Now Remote management lets our Call
Centre access your Samsung product remotely to troubleshoot a problem. e-Manual Check the E-manual stored in the device to get troubleshooting tips.
Software Update Try Now The Software Update menu allows you to upgrade the product's software for performance improvements or additional services. 1.
In the Home screen, select the Settings, and then press the E button.
2. Select Support, and then press the E button. 3. Select Software Update, and then press the E button. 4.
To download update software and update now, select Update Now, and then press the E button. 5. To let the product download update software automatically
when available, select Auto Update, and then press the E button. "" The upgrade is complete when the product turns off, and then turns on again by itself. ""
Samsung Electronics shall takes no legal responsibility for product malfunction caused by an unstable Internet connection or consumer negligence during a
software Update. "" When a system upgrade is in progress, "UPDATE" is displayed on the front panel. Update Now You can use Update Now to update the
software through your network connection or by using a USB flash drive. The network instructions are below. The USB flash drive instructions are on the next
page. 1.
Select Update Now, and then press the E button. The Update now pop-up appears. 2. The product searches on line for the latest software version. 3. If it does
not find an update, the "There are no new updates for you at the moment." pop-up appears. Press the E button to exit. 4. If it finds a new version, the Update
Request pop-up appears.
5. Select OK. The product upgrades the software, turns off, and then turns on automatically. 6. If you select Cancel, the product cancels the upgrade.
"" When the system upgrade is done, check the software details in the Product Information section of the Contact Samsung screen. "" Do not turn off the
product during the Software Update. It may cause the product to malfunction. Auto Update You can set the Auto Update function so that the product
downloads new upgrade software when it is in Auto Update mode. In Auto Update mode, the product is off, but its Internet connection is active.
This allows the product to download upgrade software automatically, when you are not using it. 1. Press the ▲▼ buttons to select Auto Update, and then press
the E button. 2. Select "Off" or "On". ●●On : The product will proceed with updating its software automatically if a new release of the software becomes
available without notifying the user. ●●Off : The product will prompt user to confirm updating when a new release of the software becomes available, which
allows user to proceed or cancel updating. "" To use the Auto Update Mode Upgrade function, your product must be connected to the Internet. Manage
Satellite Channels For BD-H8509S, H8909S model Manage software downloads via a satellite channel. Update by USB To upgrade by USB, follow these
steps: 1.
Visit www.samsung.com. 2. Click SUPPORT on the top right of the page. 3. Enter the product's model number into the search field. As you enter the model
number, a drop down will display products that match the model number. 4. Left click your product's model number in the drop down list.
5. On the page that appears, scroll down to and then click Firmware Manuals & Downloads. 6. Click Firmware in the centre of the page. 7.
Click the ZIP button in the File column on the right side of the page. 8. Click Send in the first pop-up that appears. Click OK in the second pop-up to
download and save the firmware file to your PC. 9.
Unzip the zip archive to your computer. You should have a single folder with the same name as the zip file. 10. Copy the folder to a USB flash drive. 11. Make
sure no disc is inserted in the product, and then insert the USB flash drive into the USB port of the product. 12. In the product’s menu, go to Settings >
Support > Software Update. 13. Select Update Now.
14. The product searches for the software on the USB drive. When it finds the software,the Update Request pop-up appears. 15. Select OK. The product
upgrades the software, turns off, and then turns on automatically. "" There should be no disc in the product when you upgrade the software using the USB
jack. "" When the system upgrade is done, check the software details in the Product Information section of the Contact Samsung screen. "" Do not turn off the
product during the Software Update. It may cause the product to malfunction.
"" Software Updates using the USB jack must be performed with a USB flash memory stick only. Contact Samsung Try Now Provides contact information for
assistance with your product. Reset Try Now Resets all settings to their default settings except for the network and App service settings. The default PIN is
0000. "" Password : Enter the desired 4-digit password using the number buttons.
1) Belgium, France, Italy, Norway : You can not set the password to "0000". Please choose other numbers. 2) Others : Default password is set to 0000. Your
product can play content located on Blu-ray/DVD/CD discs, USB devices, and PCs. To play content located on your PC, you must connect your PC and the
product to your network and Visit the http://link.
samsung.com site to download and install the Samsung-link program. Playing Commercial Discs 1. Press the button to open the disc tray. 2. Place a disc
gently into the disc tray with the disc’s label facing up. 3. Press the button to close the disc tray. Playback starts automatically. "" In TV view mode, the ∂
button will function as Timeshift rather than its original function, playback even if there is a disc inserted.
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"" In Home screen, the ∂ button will function as playback of multimedia content in the disc. Playing Photos, Videos, and Music (Multimedia) You can play
media content saved on a USB device, built-in HDD, smartphone, camera, computer, or cloud service on the product. "" However, you cannot play media
content if the content or the storage device are not supported by the product. "" Backup important files before connecting a USB device. Samsung shall not be
held responsible for damaged or lost files. Playing Media Content Saved on a USB Device 1. Connect your USB device to the product. 2. Press the HOME
button and select Storage in the Multimedia panel. The USB devices connected to the product are listed.
3. Select the device you wish to connect to. The folders and files in the selected USB are listed. 4. Select the media content you wish to play from the list.
The media content plays. "" Alternatively, move to the media content to play and press the ∂ button to play the content. 5. To exit, press the ∫ button or
RETURN button. "" If you connect a USB device to the product while watching the product, a popup window appears on the screen so that you can easily
navigate the folders and files of the USB device.
Playing Media Content Saved in a Computer/Mobile Device You can play media content on the product with a computer or mobile device connected to the
same network as the product. "" Only available with Samsung phones supporting DLNA functionality. "" Samsung Link software should have been installed
on the computer. The mobile device should support Samsung Link. For more information, visit Samsung’s content and service portal at
http://link.samsung.com. "" You may experience compatibility issues when attempting to play media files via a third-party DLNA server. "" However, the
content shared by a computer or a mobile device may not play depending on the encoding type and file format of the content. In addition, some functions may
not be available.
"" The media content may not smoothly play depending on the network status. If this is the case, use a USB storage device. 1. Connect the smart device and
product. 2. Press the HOME button. (Settings → Network → Content Sharing → Multimedia Device Settings) Storages devices connected to the same network
of the product are listed. 3. Select a desired storage device. The folders and files shared by the selected storage device are listed.
4. Select the media content you wish to play from the list. The media content plays. "" Alternatively, move to the media content to play and press the ∂ button
to play the content. 5.
To exit, press the ∫ button or RETURN button. Allowing Connection with a Mobile Device (HOME → Settings → Network → Content Sharing) To play the
media content stored on a mobile device, you must allow the connection between the mobile device and the product. "" You can connect to a mobile device on
any DLNA DMC device. DLNA DMC function enables users to connect a mobile device to the product, search for media content, and control play operations
on the product. 1.
Navigate to Settings > Network and select Content Sharing. The mobile devices connected to the same network as the product are listed. 2. Allow connection
with the device you wish to connect to the product. You can only play media files from devices that have been allowed to connect to the product. "" If a mobile
device requests the media content to play, the connection confirmation window appears on the product so that you can easily connect a mobile device. Playing
Media Content Saved in a Cloud Service Cloud service saves user content such as photos, videos, and music files on a server so that it can be played on the
product connected to the network. You can view the media content saved in a cloud service such as Dropbox and OneDrive on the product. "" To play the
content in a cloud service, you must log into your Samsung account and link the Samsung account to the cloud service account. For the information about
linking your Samsung account to a cloud service account, refer to "Linking Your Internet Service Accounts to the product" section.
1. Press the HOME button and select Cloud Service in the Multimedia panel. The cloud services linked with your Samsung account appears. 2. Select a
desired cloud service. The folders and files in the selected cloud service are listed. 3. Select media content you wish to play from the list. The media content
plays. "" Alternatively, move to the media content to play and press the ∂ button to play the content.
4. To exit, press the ∫ button or RETURN button. "" A Samsung smart device or a PC installed with the Samsung Link app can be connected to the Blu-ray
product through a remote network. "" To connect devices through a remote network, the same Samsung Account should be used to log in for both this Blu-ray
product and the device running the Samsung Link app. "" For further details on sharing contents with Samsung Link in remote access network, refer to the
"Register to Samsung Link" guide to enable the function.
"" For more information, visit the Samsung Content & Service portal (http://link.samsung. com). Samsung Link For more information, visit the Samsung
Content & Service portal (http:// link.samsung.
com). "" You may experience compatibility issues when attempting to play media files via a third-party DLNA server. Controlling Video Playback You can
control the playback of video content located on a Disc, USB, mobile device or PC. Depending on the disc or contents, some of the functions described in this
manual may not be available. Buttons on the Remote Control used for Video Playback Playback related buttons The product does not play sound in Search,
Slow or Step mode. ●●To return to normal speed playback, press the ∂ button. ●●∂ button : Starts playback. ●●' button : Stops playback. ●●∑ button :
Pauses playback. ●●Fast Motion Play : During playback, press the † or … button.
Each time you press the † or … button, the playback speed will change. ●●Slow Motion Play : In pause mode, press the … button. Each time you press the …
button, the playback speed will change. ●●Step Motion Play : In pause mode, press the ∑ button. Each time you press the ∑ button, a new frame appears.
●●Skip Motion Play : During playback, press the € or ‚ button. Each time you press € or ‚ button, the disc moves to the previous or next chapter or file.
Using the disc menu, title menu, popup menu, and title list ●●DISC MENU button : During playback, press this button to display the Disc menu. ●●TITLE
MENU button : During playback, press this button to display the Title menu.
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"" If your disc has a playlist, press the View button to go to the playlist.
●●POPUP MENU button : During playback, press this button to display the Popup menu. Using the Settings Menu (During the Playback) During playback
or in pause mode, press the TOOLS button. Use the ▲▼◀▶ buttons to select the button, and then press the E button. ●●Play from the beginning : Select to
return to the beginning of the movie, and then press the E button ●●Select Scene –– Search Titles : If there is more than one movie on the disc or device,
select to start a different title. 1.
Select Search Titles, and then press the E button. 2. Use the ▲▼ buttons to select a title, and then press the E button. –– Chapter Search : Select to play the
chapter of your choice. 1.
Select Chapter Search, and then press the E button. 2. Use the ▲▼ buttons to select a chapter, and then press the E button. –– Search Time Bar : Select to play
the movie from a selected time point. 1. Select Search Time Bar, and then press the E button. 2. Using the number buttons, enter the time point you want to go
to, and then press the E button. "" You can also use the ◀▶ buttons to advance or rewind the movie. The movie advances or rewinds one minute each time you
press the ◀▶ buttons.
"" If the index information in the file is damaged or the file does not support indexing, you will not be able to use the Select Scene function. "" If you run files
on network device after you have connected the player to a computer on your network, Select Scene may not work. ●●3D : Use the 3D menu when playing a
3D file. "" The 3D menu becomes available only when you are playing a 3D video file. "" When playing a 3D video, set the player to Side by Side or Top and
Bottom in 3D Settings so that the player's settings match the 3D content format. "" If you move to the Home or Smart Hub Home screen while in 3D mode, the
product will switch to 2D automatically. ●●Search –– Search Scene : You can use the Search Scene function during playback to view or start a movie from
the scene of your choice. –– Search Titles : If there is more than one movie on the disc or device, select to start a different title. –– Search Time Bar : Select to
play the movie from a selected time point. ●●Subtitle Settings : Lets you set the desired subtitle options.
●●Repeat Mode : Lets you repeat a title, chapter, or specific section. ●●Rotate : Lets you rotate the picture. ●●Full Screen : Lets you set the size of the
video image. ●●Picture Mode : Lets you set the picture mode. –– Dynamic : Increases sharpness and brightness.
–– Standard : Choose this setting for most viewing applications. –– Movie : The best setting for watching movies. –– User : Lets you adjust the sharpness and
noise reduction function respectively. "" When you use the BD wise function, this menu will not appear. ●●Audio : Use to set the desired audio language.
●●Audio Sync : Select to set the audio sync. ●●Subtitle : Use to set the desired subtitle language. ●●Angle : Lets you view a scene from another angle. The
Angle option displays the number of angles available to view. When a Blu-ray Disc/DVD contains multiple angles of a particular scene, you can change
angle. ●●Information : Lets you to view video file information. ●●BONUSVIEW Video, BONUSVIEW Audio : Use to set the desired bonusview option. ""
Depending on the disc or storage device, the Settings menu may differ. "" Video files with high bitrates of 20Mbps or more strain the product's capabilities
and may stop playing during playback. Using the View & Options Menus Using the View Menu On a file screen containing video files, select and then press
the E button.
●●Date : Groups all the the photo files on the media or storage device by date. Click a group to see the videos in that group. ●●Title : Displays all the video
files on the media or storage device by title. ●●Folder : Displays all the folders on the media or storage device in alphabetical order. "" Depending on the
disc or storage device, the View menu may differ or not appear. Using the Options Menu On a file screen containing video files, select and then press the E
button. ●●Play Selected : Play Selected lets you select specific file to play. It works essentially the same for all media. ●●Send : Select Send to upload
selected files to a web site (Picasa, Facebook etc) or device. To use Send, you need to establish an account with the on-line site, and then log in using the Log
In function.
Controlling Music Playback You can control the playback of music content located on a Disc, USB, mobile device or PC. Depending on the disc or contents,
some of the functions described in this manual may not be available. Buttons on the Remote Control used for Music Playback ●●NUMBER buttons : Press
the number of a track. The selected track is played. ●●€ ‚ button : Move to the previous/next track.
●●' button : Stops a track. ●●Fast Play (Audio CD (CD-DA) only) : During playback, press the † or … button. Each time you press the † … button, the
playback speed will change. ●●∑ button : Pauses a track. ●●∂ button : Plays the currently selected track.
"" If you don't press a button within five seconds of inserting an Audio CD, the screen is displayed in Full Screen mode. To go back to the Play List screen,
press the RETURN button on the remote control. Using the Options Menu (During the Playback) On the music file playback screen, use the ▲▼◀▶ buttons to
select the and then press the E button. ●●Save as playlist : Select to save as playlist. ●●Play Selected : Play Selected lets you select specific tracks to play. It
works button, essentially the same for all media. See the "Repeating tracks on an Audio CD". ●●Ripping : The Ripping function converts CD audio to the
mp3 format and saves the converted files on a USB device or a mobile device connected to the product. ●●Information : Select to see the (Contents)
information. "" Depending on the disc or storage device, the Settings menu may differ or not appear.
Using the View & Options Menus (On a file screen) Using the View Menu On the playback screen, button and then press the E button. ●●Track : Displays all
the music tracks on the media or storage device in alphabetical order. ●●Album : Displays all music on the media or storage device by album. ●●Artist :
Displays all the the music files on the media or storage device by artis. ●●Genre : Displays all the music on the media or storage device by genre. ●●Folder
: Displays all the folders on the media or storage device. "" Depending on the disc or storage device, the View menu may differ or not appear.
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